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REGISTRATION

We at Computer Witchcraft believe that Mega Edit is a product meeting the highest 
standards of excellence in design and software craftsmanship.    We hope that you agree!    

As an additional benefit to the consumer, Mega Edit has been released as Shareware, so 
that you can try out the software on your system to see if it meets your needs "before you 
buy."    If you make the determination that you would like Mega Edit to become a part of 
your software library, you should take responsibility to pay for the product by registering it. 

BENEFITS OF REGISTRATION:

                - Latest version
                - Manual in Write format
                - Registration information on About screen
                - No shareware registration screen
                - Technical support via CompuServe/Internet
                - On our mailing list
                - Upgrade protection
                - Total Customer Satisfaction guarantee

When you register Mega Edit you will receive a diskette containing the latest version of the 
product. We are continually improving Mega Edit (TM) and releasing new versions so it is 
quite likely that your registered version will be a more recent version than the one you 
picked up via shareware channels. 

You will receive a copy of the Mega Edit (TM) manual in Microsoft Write format.    Your name 
and/or company name will appear on the About screen, but your copy of Mega Edit (TM) will 
otherwise be free from start-up screens or registration screens of any kind. 

Registered users are eligible for Technical Support via CompuServe, Internet mail, fax, or by 
telephone.      

We will put you on our company's mailing list, so that you will receive materials describing 
the availability of upgraded editions of the software and other new products from Computer 
Witchcraft that may be of interest to you.

Upgrade protection!    When you register Mega Edit (TM) you will receive the most recent 
version of Mega Edit (TM), but we are always improving the product.    At some point in the 
future you may find a newer (later) version of Mega Edit (TM) out as shareware.    Not to 
worry!    Registered users can just install the newer shareware version with the registration 
file from the older version and consider your new version registered!    The new software will 
display your name and company information on the About screen and will eliminate any 
registration screens.    This feature will work for all new shareware versions at least up until 
the next major release.

We strive for Total Customer Satisfaction and will happily refund your money, including 
shipping and handling charges, if for any reason you are unsatisfied with our product - you 
do not have to 
return the product.

HOW TO REGISTER:

As of this date, January 1, 1992, the Registration Fee for Mega Edit (TM) is $35.50 in U.S. 



Dollars, PLUS a shipping and handling fee, (see table below).    

For your convenience, you may order/register using your credit card 24 hours a day by 
Telephone, FAX, or Electronic Mail.    We accept Master Card, Visa, Discover, American 
Express, JCB Cards, Carte Blanche, and Diners Club.

                Telephone:    (415) 752-2477      (If no one answers,    please leave your order on 
VOICE MAIL).
                FAX                  (415) 752-8971

                Electronic Mail:    CompuServe:            76130,1463
                  Usenet/Internet: megaedit@witchcraft.com

If not registering by mail, please include essentially all of the information that is on the 
registration form (REG_FORM.TXT).    If registering by VOICE mail, please speak clearly and 
repeat all of the important information - your name, address, credit card information, and 
media on which to send you your copy of Mega Edit (TM).

You may of course register by REGULAR MAIL and use either Check, Money Order, or Credit 
Card to pay.    Please make all Checks or Money orders payable to COMPUTER WITCHCRAFT, 
INC. in U.S. dollar denominated drafts drawn on a U.S. bank.    The cost to us for non-U.S. 
checks is prohibitive.

Our address is:
                                                Computer Witchcraft, Inc.                          
                                                Post Office Box 210441
                                                San Francisco, CA, 94121-0441
                                                U.S.A

Please send the TOTAL that includes the appropriate shipping and    handling fee from the 
following table:
                              
                Country                  Registration      Shipping/handling            TOTAL
                -------------                -----------------      --------------------------            -----------
                Unites States            $35.50                        $3.50                                  $39.00
                Canada & Mexico 35.50                            5.00                                    40.50
                Other countries          35.50                            9.00                                  44.50

If REGISTERING BY MAIL, please enclose the registration form included with the Mega Edit 
(TM) distribution (REG_FORM.TXT).
    
NOTE: If for some reason you cannot print the registration form (perhaps you don't have a 
printer!), it's fine just to send a note with the registration information along with your check, 
money order, or credit card information. 
 
PLEASE ALLOW UP TO FOUR WEEKS FOR DELIVERY. (We will try to do better than that). 

------------------------------------------------------------------------------------------------------------------------------
REGISTRATION      FORM

Click or select 'Registration Form' below to bring up the actual form you can use to register 
Mega Edit.    You can use then Help application's File/Print command to get a hard copy 
version.    Alternatively, you can use the Help applications Edit/Copy command to 
copy the form to the clipboard, and then into paste the form into Mega Edit.    
You can then type in your information and print the completed form.



Registration Form
When complete, please mail the form and payment to:

                Computer Witchcraft, Inc.
Post Office Box 210441

                San Francisco, CA, 94121-0441

THE REGISTRATION FORM CAN ALSO BE FOUND IN THE    FILE 
'REG_FORM.TXT', INCLUDED WITH YOUR PRODUCT FILES.
------------------------------------------------------------------------------------------------------------------------------
In case of problems receiving your product disk, or simply to leave a message about 
anything you like, you may call 415-752-2477., or send a FAX to 415-752-8971

THANKS FOR REGISTERING MEGA EDIT.    STAY IN TOUCH!                                                                     



PRODUCT REGISTRATION FORM
PRODUCT REGISTRATION FORM 
Mega Edit (TM) Version 2.06     Name:  _________________________________
(REG_FORM.TXT)
                     Company/Address:  _________________________________

                                       _________________________________

                                       _________________________________

               Your Telephone Number:  _________________________________
                                       (include area/country code)

               Disk Media, check one:  [ ] 5.25"  [ ] 3.5"

                        Date Ordered:  Month ________  Day _____  Year ______

Registration Name (Capitalization and Punctuation will be exactly as listed)
-----------------
                Your Name (required):  _________________________________

        Company/Org. Name (optional):  _________________________________

Credit Card Orders      Please Check:  [ ] MasterCard  [ ] Visa  [ ] JCB
------------------                     [ ] American Express  [ ] Discover 
                                       [ ] Carte Blanche  [ ] Diners Club
                  
                  Credit Card Number:  _________________________________
                     
                     Expiration Date:  Month ________  Year ______

              Cardholder's Signature:  _________________________________
             (for Mail or Fax orders)

Price Calculation   Registration Fee:  $35.50
-----------------
  California residents add Sales Tax:  ___________
                                                    $3.50 Unites States
               Shipping and Handling:  ___________  $5.00 Canada & Mexico
                                                    $9.00 Other countries
                          Total Cost:  ___________

Checks or Money orders:  Make payable in U.S. currency on a U.S. bank. 
Credit card payments may be sent via mail, E-Mail, FAX, or telephone.

   Computer Witchcraft, Inc.            Internet:   megaedit@witchcraft.com
   P.O. Box 210441                      CompuServe: 76130,1463
   San Francisco, CA 94121-0441         Fax:        (415) 752-8971
   U.S.A.                               Telephone:  (415) 752-2477

How did you receive your copy of Mega Edit (TM)?    -- Thanks!
------------------------------------------------
[ ] CompuServe  [ ] BIX  [ ] Genie  [ ] AOL  [ ] Other BBS __________________
[ ] Catalog ______________________  [ ] Other _______________________________



OVERVIEW
Mega Edit    is a powerful ASCII text editor.    It is designed specifically to facilitate complex 
editing tasks involving multiple and/or large files, where such tasks would be difficult or 
impossible with most editors currently available for MS Windows 3.x.    

In addition to the usual capabilities of any Windows 3.x CUA compliant text editor, its 
features include: 

Support for very large file editing -- up to the amount of available virtual memory on 
systems running in 386 Enhanced mode.    With 16 megabytes of RAM installed, this can be 
up to about 64 megabytes.    (In general, when running in 386 Enhanced mode, Windows 
will support about 4X the amount of installed physical RAM).    Mega Edit has NO PRESET 
LIMITS for file size capability.

Support for multiple file handling--you can load up to 25 files at once.

Support for Multi-Platform file formats--the editor can automatically recognize and 
load MacIntosh and Unix text files, as well as standard DOS text files.    It also has an 
Export/Conversion capablility for outputing files loaded in any one of the aforementioned 
formats to any of the others.

Binary File Viewing--the editor also allows loading of binary files for viewing.    When a 
binary file is loaded, it is displayed in a clean, 72 character per line format.    

A split screen feature--allows you to scroll through and edit the same document at two 
places simultaneously, or to view and edit different documents    simultaneously.

Support for variable, sizeable fonts.            

Word Wrap.

Mega Edit System Requirements:
80286 or higher processor.
Window'sStandard or Enhanced modes
VGA or higher resolution monitor recommended.
Mouse recommended



Editing Multiple Files
Please note that each time you load a new file during an editing session, that file 
remains in memory, even when you open or create a new file.    

After opening one or more files, you will observe that the names of these files are 
appended to the bottom of the file menu.    You can switch from one file to another by 
selecting the desired filename from the file menu. 

Note that multiple file handling is supported by the split window feature, so that, once you 
have split the editing area, you can open or switch to a new file in the current pane and 
retain the original file in the other pane.

When you switch from one file to another, the line and column position of the caret is 
retained so that when you switch back, you can resume editing where you left off.

It is not necessary to explicitly save a file when opening or creating a new one.    You can 
save the file at any time by switching back to it and selecting the 'Save' option from the file
menu.    If you exit the editor, you will be prompted to save any unsaved files in memory.  



SPLIT WINDOW FEATURES
Mega Edit supports the splitting of the main edit window into two separate panes of the 
same number of lines.    You can split the edit window by either pressing Ctrl+S or by 
selecting the 'Split Window' option from the Window menu.

Initially, when you split the edit window in two, the same file exists on both sides of the 
divider that appears.    You can now scroll each window 'pane' independently, using either 
the keyboard or one of the two scroll bars beside each pane, as well as performing any 
other editing functions on either side of the divider. 

You can also open, create or switch to additional files on either side of the divider, so that 
more than one file is visible in the editing area at the same time. 

After splitting the main editing area, you can switch between the two sides of the partition 
either by clicking the mouse in the opposite partition or by selecting the 'Switch Pane' 
option from the Window menu.    The accelerator key for this operation is Ctrl+W.

Finally, you can resume editing in single window mode by selecting the 'Unsplit Window' 
option from the Window menu.    The accelerator key for this operation is Ctrl+X.    When 
you unsplit the window, the file that contained the caret just prior to your issuing the 
unsplit command becomes the current file, and the caret position is retained.    



Keyboard Commands
Navigation
    Beginning of document: Ctrl+Home
    End of document: Ctrl+End
    Start of line: Home
    First character of line: Home+Home
    End of line: End
    One word right: Ctrl+Right
    One word left: Ctrl+Left

General Functions
    Insert line: Ctrl+N
    Delete line: Ctrl+Y
    Delete to end of line: Shift+Ctrl+Y

Extend Selection
    Line up: Shift+UpArrow
    Line down: Shift+DownArrow
    Character right: Shift+RightArrow
    Character left: Shift+LeftArrow
    Page up: Shift+PgUp
    Page down: Shift+PgDn
    To end of document: Shift+Ctrl+End
    To start of document: Shift+Ctrl+Home

Accelerator Keys (Menu short cut keys)
    Help: F1

    Save file: F2
    DOS shell: F12
    Exit application: Alt+F4

    Cut selected text: Shift+Del
    Copy selected text: Ctrl+Ins
    Paste Clipboard contents
        at current location: Shift+Ins
    Clear selected text: Ctrl+Del

    Find again: F3
    Goto line or % of document: Ctrl+G

    Split window: Ctrl+S
    Switch pane: Ctrl+W
    Unsplit window: Ctrl+X

    (Courier font Only)
    Enlarge text: Ctrl+NumKeypad Plus
    Reduce text:: Ctrl+NumKeypad Minus

    Print current file: Ctrl+P



File Menu Commands
New, Open, Save, Save As, Save All, 
Close, Close All, Include File, Export/Convert,
Run DOS Shell, Exit

New
Choosing 'New' allows you to create a new, unnamed file for editing.    Initially, the file is 
named 'noname'.    When you save the file, you will be allowed to rename it something 
more distinctive.

Open...
Choosing 'Open' allows you to load a pre-existing disk file into memory for editing.      Using 
various fonts that are available on the Options/Change Font menu, it is possible to view and
edit files that are in any of the standard DOS text formats -- plain ASCII, ANSI, or OEM 
(ASCII plus IBM    graphics characters), as well as standard MacIntosh and Unix text files.   
When a MacIntosh or Unix file is loaded, edited, and subsequently saved, it retains its 
original MacIntosh or Unix file format, unless you specifically convert the file to another 
format using the 'Export/Convert' menu choice (described below...).    

Please see help for the Options/Change Font menu for more information on getting the best
match between file format and character font.

NOTE: Mega Edit also lets you load binary files for viewing only.    When you load a 
binary file, the editor will automatically detect that it is in binary format and display the file
with 72 character    length lines. This provides for a very clean, comprehensible display of 
the data.    If you try to save a binary file once it has been loaded, the editor will prevent 
you from doing so.    (To actually edit binary files, use a hexidecimal editor).

Save F2
Choosing 'Save' will cause the current file to be saved to disk.    If the file is currently 
named 'noname', which is the default for files created with the Edit menu's 'New' 
command, you will be prompted for a file name of your own divising.

NOTE: Files originally loaded with MacIntosh or Unix formats retain their native 
characteristics when saved with any of the 'Save' commands.    To modify the operating 
system format of a text file, use the 'Export/Convert' menu choice, described below...

Save As...
Choosing 'Save As' will bring up a dialog prompting you for a new name for the current file. 
After you supply the new name, the file will be committed to disk under the new file name, 
and will also be known within the Mega Edit environment by the new name from hence 
forth.

Save All
Choosing 'Save All' will cause all files currently loaded into the editor to be saved to disk.    
A dialog box willcome up asking you to give your own name to any files created with the 
'New' command as having the name 'noname', (see comments above about the 'New' 
command).

Close
Choosing 'Close' will cause the current file to be closed.    If the file has been modified since
it was last saved, (the file name at the bottom of the screen turns to red whenever 
it has unsaved modifications), you will be asked if you would like to save the file before 
closing it.    If you say 'Yes', the file will be saved to disk before it is closed, including 



allowing you to rename files name 'noname'.

Close All
Choosing 'Close All' allows you to close all currently open files with one command.    If any 
open files have modifications, you will be prompted about saving them, as with the 'Close' 
command.

Include File...
Choosing 'Include File' allows you to incorporate a file existing on disk into the currently 
open file at the point where the caret is currently positioned.    A dialog box will be 
presented similar to that which appears when you select the Edit menu's 'Open' command. 
When you have finished identifying a file with this dialog box, it will be immediately pulled 
into the current document at the current position of the caret.

Export/Convert
Choosing 'Export/Convert' allows you to output the current file a different 
platform/operating system file format .    This menu choice contains a sub-menu with three 
options, DOS text..., MacIntosh Text..., and Unix Text...,    Choose the desired output 
file format, and then respond to the 'File Save As' dialog box to either retain the same 
filename or rename the file, according to your needs.      Using the 'Export/Convert' facility, 
you can repeatedly convert a file between the three different formats.

Run DOS Shell F12
Choosing this option will cause a copy of the DOS operating system to be spawned, 
allowing you access to the DOS prompt.    If you are running in 386 Enhanced mode, you 
can hit Ctrl+ENTER to window this process, and in any mode you can hit Ctrl+Esc to switch
back to Windows.    The DOS shell you spawn will continue after you exit Mega Edit, unless
you explicitly close it.    Once started, it is entirely independent of Mega Edit.

Exit Alt+F4
Choosing 'Exit' is the same as choosing 'Close' from the system menu.    It causes the 
Mega Edit application to shut down and exit.    Before the Mega Edit completely shuts 
down, you will be prompted about saving any unsaved, modified files. 



Search Menu Commands
Find, Again, Replace, Goto

Find      
When you choose 'Find', a dialog box will prompt you for one or more characters or words 
for which you would like to search.    

NOTE:    Instead of typing the search text directly in to the input of the dialog box that 
comes up when you select Search/Find, you may preselect the search text by 
highlighting the text in the document with the mouse or the keyboard before you 
select Search/Find.      If you do this, the text you selected from the document will appear in 
the dialog input automatically.    

Beneath the input for the search text, there are several check boxes that allow you to tailor
the specifics of how the search will be conducted:

If you check the 'Start at first line' box, the search will commence from the first 
line of the current document.    If you      uncheck this box, the search will 
commence from the current position of the caret. 

If you check the 'Case sensitive' box, the search will match only with a case-
exact match of the search text you supply.    If this box is unchecked, the case of 
the characters will be ignored for matching purposes.

If you check the 'Whole words only' box, the search will reject as a match any 
text found that matches your search text but that is surrounded on either side by 
alphabetic characters.    This can help you weed out matches such as might result 
when you are looking for the word 'super' when the characters in 'super' occur in 
words such as 'supercalafragalisticexpialadochious'.    If you leave this box 
checked, matches will be accepted when your search text is found as part of a 
larger group of characters.

After supplying the search text and configuring the criterion for the search as described 
above, and after selecting OK, a rapid, literal search will be conducted through the text of 
current document.    If a match is found, the line containing the matching text will be 
centered in the edit area and the caret will be placed immediately after the last character 
in the matching text.

Again F3
Choosing 'Again' repeats the most recent search that you have configured and run 
previously, starting always from the current position of the caret in the current document.    
The accelerator key for this is F3 --    it is much more convenient to use the accelerator key 
for this operation rather than selecting it from the menu.

Replace      
Choosing 'Replace' allows you to configure and run an operation that substitutes one group
of characters for another at one, several, or all locations where the text occurs in the 
current document.    As with the 'Find' operation, a dialog box appears prompting you for 
search text.    

NOTE:    Instead of typing the search text directly in to the input of the dialog box that 
comes up when you select Search/Replace, you may preselect the search text by 
highlighting the text in the document with the mouse or the keyboard before you 
select Search/Replace.      If you do this, the text you selected from the document will 
appear in the dialog input automatically.    



Additionally, you are prompted for the replacement text that will be substituted for the 
search text.    It is acceptable not to list anything as the replacement text, in effect 
telling the dialog box that you want to delete instances of the search text.    

As with 'Find' you can also configure details of the operation via the checkboxes located 
within the box labeled 'criteria.    These check boxes work the same as in 'Find', (See 
above), except that there is an additional checkbox, called 'Confirm changes'.    If this box
is checked, you will be prompted whenever a match is found for your search text as to 
whether this particular instance should be replaced by the substitution text.    The dialog 
that appears to interact with you on this question also includes a Cancel button, allowing 
you to halt the whole operation at any point.      You should make sure this box is 
checked if you have any question that certain instances of your search text 
should NOT be replaced by the substitution text.    If you are certain that all instances
should be replaced, it is best to leave this box unchecked as the operation proceeds much 
more efficiently when it is not necessary to prompt about each instance. 

Goto      
Choosing Goto brings up a dialog box prompting you for a number.    This number is 
ordinarily interpreted by the Goto operation as the number of a line in the current 
document.    Optionally, you can configure the operation to interpret the number you enter 
as a percentage of the document rather than as a line number.    If for example you enter 
75 as the number, and change the radio button to indicate that Goto should interpret the 
number as a percentage, when you click OK, the editor will locate and center on the CRT 
the line that occurs at a point 3/4ths of the way through the current document.    Otherwise,
the editor will locate and center the line corresponding exactly to the number you entered 
in the Goto dialog box.



Window Menu Commands
Split Window, Unsplit Window, Switch Pane

These commands control the Mega Edit's split screen features.

Split Window Ctrl+S
Choosing 'Split Window' will cause the editing area to be subdivided into two equal sections
separated by a divider.    Initially, the same file exists on each side of the divider, allowing 
you to scroll through and edit two parts of the file simultaneously.    The split screen feature 
is integrated with multiple file handling features so that it is possible, once you have split 
the screen to load or create new files, or to switch to other currently loaded files, on either 
side of the divider.    Current caret positions are retained in all loaded files, so that when 
you switch a file into one of the visible panes, your position within a given document 
remains what it was when you lasted worked with the file.

Unsplit Window Ctrl+X
Choosing 'Unsplit Window' causes the split editing area to revert back to a unitary window, 
with the document currently containing the caret to fill the entire area.

Switch Pane Ctrl+W
Choosing 'Switch Pane' causes the caret to move from one side of the divider separating 
the two editing areas to the other, and makes the    file on that side the current file.    You 
can also move the caret from one side of the divider to the other by clicking with the 
mouse.    



Options Menu Commands
Word Wrap, Set Tab, Colors, Change Font, 
Enlarge Font, Reduce Font, Preferences

Word Wrap On/Off      
Choosing this command toggles Mega Edit's word wrap feature on and off.    If word wrap 
is currently on, a check mark appears by this menu choice.    You can set the right hand 
margin where wrapping occurs via the Options/Preferences dialog box .    The 
Options/Preferences dialog box also lets you set a default start up behavior for word wrap.   
(More information on the Options/Preference menu choice follows below...)

Set Tab      
Choosing this option lets you set the value of tab stops in Mega Edit.    Tab stops are 
positioned at a columnar interval across the editing area, and the value you supply here 
when prompted sets this interval, the unit being the width of a character.    You can set the 
default start up tab interval via the Options/Preferences dialog box (see below).

Colors
Options on this pop-up menu let you choose between three different color sets for the 
editing area of Mega Edit:

Choosing 'Standard Colors' will cause the editing area colors to correspond to the 
colors set in your system.ini file.    These colors can in turn be controlled via the 
Windows 'Control Panel' utility, or some other utility that allows you to tailor 
Windows various system colors.    'Standard Colors' is the factory default, and allows 
you to best      customize colors for certain types of monitors which support color 
irregularly or which only have monochrome colors (such as laptops). 

Choosing 'Metallic Colors' will cause text to appear as black on a      silver 
background.    Additionally, the reverse video highlight colors will be white text on a 
dark grey background.    This color combination is attractive and very easy on the 
eyes, and is recommended for VGA or better CRTs. 

Choosing 'Maze and Blue' will cause text to appear as gold on a sky blue 
background.    Highlight colors will be red text on a powder blue background.    
Another attractive color set for VGA CRTs. 

Change Font
This pop-up menu allows you to customize Mega Edit's text fonts to best suit your taste, 
viewing conditions, and text format.            

Choosing 'Courier Font' selects Mega Edit's most flexible font, the courier font.    
This is the only font supported that allows you to use the Options/Enlarge
and Options/Reduce font controls to size the font for maximum visibility.  
The courier font is an ANSI font.    To      view/edit files that have IBM extended ASCII
characters, you should      select the OEM (IBM) font.

Choosing 'ANSI Font' selects the Window's ANSI font.    

Choosing 'OEM (IBM)' font selects a font modeled after that which,      prior to the 
widespread use of MS Windows, served as the default text font for DOS and DOS 
applications for IBM and compatible computers.        The Windows OEM (IBM) font 
supports most of the extended character set that is part of the OEM font, and is 
useful for viewing files produced with DOS applications that might have these 
characters (mostly line and box drawing characters, along with a variety of special 



symbols, for mathematics, et.    OEM extended characters will appear as the 
corresponding characters from the ANSI character set if one of the other fonts is 
selected, but these will probably not match the original symbols in the OEM font.

Choosing 'System Font' will select the Window's fixed width system font.    This is 
the same font used by the 'NotePad' utility supplied      with the retail Windows 
product. 

Enlarge Font      
This option can only be selected when you have set the default font to 'Courier' 
from the 'Options/Change' Font pop-up menu.    Selecting it will cause a magnification of 
the display of the courier text of your document.    You can select this option repeatedly 
until the maximum amount of magnification has been reached.    It is easier to control this 
operation by using the keyboard accelerator, Ctrl+Numkeypad Plus.    Note: on some 
systems, eliciting this choice once only may not produce a change in the size of the font.    
Try hitting Ctrl+Numkeypad Plus repeatedly until a change in the font size occurs. 

Reduce Font 
This option can only be selected when you have set the default font to 'Courier' 
from the 'Options/Change' Font pop-up menu.    Selecting it will cause a decrease in the size
of the display of the courier text of your document.    You can select this option repeatedly 
until the minimum display size of the font has been reached.    It is easier to control this 
operation by using the keyboard accelerator, Ctrl+Numkeypad Minus. 

Preferences
Choosing 'Preferences' invokes a dialog box that allows you to set some default behaviors 
of Mega Edit to best suit your use of the product.    When you modify values in the 
preferences dialog and click OK to exit, your changes are retained from one editing session 
to the next, until you again invoke this dialog and make changes:

Tabs: Default setting :        The value you supply here becomes the default tab 
interval that is set when you start up a Mega Edit session.    You can also change this
value 'on the fly' by modifying the value here or with the 'Options/Set Tab' menu 
choice. 

Word Wrap: Start up in Word Wrap Mode :        If this check box is checked, Mega
Edit will start up assuming that    you want the word wrap feature turned on for all 
documents.    You can override the default during a particular editing session by 
selecting Options/Word-Wrap On/Off to toggle the word wrap feature to the desired 
state, (see above).    If you uncheck this box, Mega Edit will start up assuming that 
you do not want to use the word wrap feature in each new document.    Again, 
override the default at any time by toggling the feature with the Options/Word-wrap 
On/Off menu choice. 

Word Wrap: Right Margin At:          The value you enter here will indicate the 
character position for    each line at which text should be wrapped to the next line 
when the word wrap feature is toggled on.      This is measured in character width 
units.    In effect, the value here represents the maximum line length in characters.

Default Search Criteria:          The states of these various check boxes will determine
the default configuration that appears pre-selected in the dialog that appears when 
you select 'Find' from the 'Search' menu.    Please see help on the Search/Find 
command for specific details.

Default Replace Criteria:          The states of these various check boxes will 



determine the default configuration that appears pre-selected in the dialog that 
appears when you select 'Replace' from the 'Search' menu.    Please see help on the 
Search/Replace command for specific details. 

Default File Mask:          The 'default file mask' is the 'wildcard' text that appears by   
default in all dialog boxes that involve opening new files for loading or importing into 
Mega Edit.    This 'mask' or 'wildcard' can be used to derive a specific subset of files 
from the entire list of    files that would appear in the 'Files' list box of these dialog 
boxes.    The factory default of '*.*' selects all files, without doing any filtering.    A 
mask text of '*.txt' would filter all files in the current directory except those with the 
extension '.txt'.      If you use Mega Edit to work with files that follow specific naming 
conventions, such as program source code files, ('*.c' for 'C', or          '*.pas' for Pascal), 
or if you impose naming conventions on your files for organizational purposes, you 
might want to consider setting the default file mask to perform some filtering for you. 
Otherwise, just leave it set to the factory default of '*.*'.              



Edit Menu Commands
Cut, Copy, Paste, Clear

Selecting text
To use the Cut, Copy, or Clear commands on this menu, you must first select some text 
from the current document so that the command has an object upon which to operate.      

Cut Shift+Del
Choosing 'Cut' causes the selected text to be excised from the document and also placed 
the Window's Clipboard where it is available for subsequent pasting either to another 
location or to another file loaded into Mega Edit or to another application altogether (for 
example, your wordprocessing application, or to a terminal emulation program).

Copy Ctrl+Ins
Choosing 'Copy' causes the selected text to be placed in the Window's Clipboard where it is
available for pasting into another location or file, or into another application altogether.    
The selected text in its current location is not affected. 

Paste Shift+Ins
 When the 'Paste' option is selectable from the Edit menu, the Window's Clipboard contains 
contents compatible with Mega Edit (i.e., some form of ASCII text).    You may position the 
caret at any position within an open file and select 'Paste' to insert the contents of the 
clipboard at the location of the caret.    The text will flow into place as though you had 
typed it yourself, leaving the caret at the end of the text that was pasted in. 

Clear Ctrl+Del
Choosing 'Clear' causes the selected text to excised from the document where it appears 
highlighted.    The text is not placed in the Clipboard.    Use this option when the Clipboard 
contains data that you do not want to overwrite. 



Selecting Text
USEFUL TIP: When you select text with any of the methods below, notice that whole lines,
including the invisible newline at the end of the lines, are selected when the highlight 
extends all the way to the right edge of the editing area, next to the scroll bar, and 
conversely, newline characters at the ends of lines are not selected when the highlight 
does not extend all the way to the right.    Selecting or not selecting whole lines, including 
the new line at the end of each line subtly effects how various Edit menu operations 
behave.    Experiment with this to get a good understanding of how cut and paste 
operations work.

You can select text either with the mouse, the keyboard, or the scroll bar.

Selecting with the Mouse:      
To select text with the mouse, first click the left mouse button at a point in the text which 
you wish to have serve as the origin point for the selection.    You may continue to hold the 
left mouse button down as you drag the cursor in any direction.    All text between the 
original origin point and the current location of the cursor becomes selected, as indicated 
by the reverse video highlighting of the selected region.    If you drag the cursor outside of 
the editing window, the editor will perform automatic scrolling to expand or contract the 
selection in any direction. Once you have highlighted the region you wish to select, release 
the left mouse button.    You may then continue to modify the currently selected region 
using combinations of the SHIFT key and various caret navigation keys, such as the arrow 
keys, the home and end keys, and the Page Up, and Page Down keys, or, alternatively, use 
to scroll bar to scroll through your document and SHIFT CLICK to extend the selection to a 
new position.

Selecting with the keyboard:      
To select text with the keyboard, first position the caret at a point in the text which you 
wish to have serve as the origin point for the selection.    You can position the caret either 
by left-clicking with the mouse or by navigating the caret to the desired position with the 
keyboard.    To start selecting, hold down the SHIFT key in combination with one of the 
various caret navigation keys, such as the arrow keys, the home and end keys, and the 
Page Up, and Page Downs keys.    Continue these techniques until the section of text that 
you wish to select is highlighted in reverse video.

Selecting with the scroll bar: 
To select text with the scroll bar, first position the caret at a point in the text that you wish 
to have serve as the origin point for the selection.    Next, using the scroll bar, scroll up or 
down through the document by clicking above or below the thumb, by dragging the thumb,
or by clicking on the scrollbar up and down arrows, until you reach to place in your 
document where you want to mark the other end of your selection.    (Notice that the caret 
remains 'stuck' to the origin point of the selection, and if your scroll a full windowfull or 
more, will no longer appear on the screen).    Finally, hold down the SHIFT key while 
pointing the cursor at the point in your text that will serve as the end-point for your 
selection, and CLICK the left mouse button.    The caret will be placed where you clicked 
and your selection will appear highlighted.    You can continue to modify or refine your 
selection, if you wish, by holding down the SHIFT key and using the keyboard, by 
continuing to hold down the left mouse button after you CLICK and dragging, or by using 
the scroll bar again.    As long as you use the scroll bar to move around your document, the 
selection remains 'sticky' and you can SHIFT CLICK somewhere else to redefine the end-
point of your selection.



Print Menu Commands
Print File

Print File Ctrl+P
    Choosing 'Print File' causes the current file to be printed on the currently selected and 
configured printer.


